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Programme

Lundi 6 février:
9h-12h : Introduction, plateforme Southgreen, environnement Galaxy.

Manuel Ruiz, Jean-François Dufayard, Dominique This.
13h-16h : Traitement des données NGS, formatage, mapping et assemblage.

Gautier Sarah, François Sabot, Jean-François Dufayard, Dominique This.
16h-17h : Mise en perspective, workflows et traitement de données NGS.

Gautier Sarah, François Sabot, Jean-François Dufayard, Dominique This.

Mardi 7 février:

9h-12h : Traitement des données NGS, formatage, mapping et assemblage (suite).

Gautier Sarah, François Sabot, Jean-François Dufayard, Dominique This

13h-16h : Recherche et analyse de polymorphismes, SNP.

Alexis Dereeper, François Sabot, Jean-François Dufayard, Dominique This.

16h-17h : Mise en perspective, polymorphisme et sélection.

Alexis Dereeper, François Sabot, Jean-François Dufayard, Dominique This.

Mercredi 8 février:

9h-12h : Annotation des éléments transposables.

François Sabot, Gaetan Droc, Jean-François Dufayard, Dominique This.

13h-16h : Annotation de gènes.

Gaetan Droc, Franc-Christophe Baurens, Olivier Garsmeur, Dominique This.

16h-17h : Mise en perspective, annotation.

Gaetan Droc, Franc-Christophe Baurens, Olivier Garsmeur, Dominique This.

Jeudi 9 février

9h-12h : Prédiction de structures 3D de protéines

Cécile Fleury, Frédéric de Lamotte, Jean-François Dufayard, Dominique This.

13h-16h : Analyse phylogénétique, orthologie et paralogie.

Jean-François Dufayard, Cécile Fleury, Dominique This.

16h-17h : Mise en perspective, génomique et protéomique comparative.

Cécile Fleury, Frédéric de Lamotte, Jean-François Dufayard, Dominique This

Liens utiles

Site de la formation

http://southgreen.cirad.fr
Programme de la formation et liens vers les supports

http://southgreen.cirad.fr/?q=content/formation-04-09022011-analyse-bioinformatique-de-s%C3%A9quences-pour-lam%C3%A9lioration-des-plantes
Galaxy

http://gohelle.cirad.fr/galaxy/root
SEQAnswers

http://seqanswers.com/
Explications pour un fichier SAM

http://bio-bwa.sourceforge.net/
Aller dans SAMtools (Links) puis cliquer sur SAM Spec v1.4
Tablet

http://bioinf.hutton.ac.uk/tablet/webstart/tablet.jnlp
Site explicatif de Tablet (FAQ)

http://bioinf.hutton.ac.uk/tablet/faq.shtml
SniPlay

http://sniplay.cirad.fr
BioEdith (edition d’alignement)
http://www.mbio.edu/bioedit/bioedit.html
PhyMOL
http://southgreen.cirad.fr/?q=content/formation-04-09022011-analyse-bioinformatique-de-s%C3%A9quences-pour-lam%C3%A9lioration-des-plantes
Modeller (prédiction de structure 3D)

http://salilab.org/modeller/
PSIPRED 

http://bioinf.cs.ucl.ac.uk/psipred/
Cours 1 : Introduction, présentation de la plateforme Southgreen

http://southgreen.cirad.fr
Faire face à la gestion de données importantes. Plusieurs générations de séquençage et accélération :

1ère génération de séquençage : Sanger : 4 radicaux marqués différemment. Arrêt de l’élongation à tous les nucléotides (400 nucléotides, 3 jours) grâce à l’enlèvement d’un groupement OH => terminateur de synthèse et ajout d’un fluorophore propre à chaque base.

2ème génération de séquençage : Nouvelle génération : 454 (pyroséquençage, billes), Solexa (fragments fixés sur plaque, reads plus petits en grand nombre).

3ème génération de séquençage : Mobilisation d’un brin unique, détection de la synthèse d’un seul brin. Procédé mis au point par Pacifique Bioscience. Le signal est détecté lors de la polymérisation alors que la polymérase est fixée dans une alvéole (20kb).

Comparaison des différentes techniques
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Différences de taille des lectures entre ces technologies et beaucoup d’erreurs.

NGS (next generation sequencing)

· Grande quantité de données

· Séquences courtes et grande redondance : erreurs

· Coût et stockage

GALAXY  est une plateforme qui permet de générer des chaines de traitements automatiques. On peut l’utiliser en vue de plusieurs applications : Et pourquoi pas dans le futur pour la métagénomique qui consiste à séquencer un échantillon prélevé sur le terrain (petit volume de terre par exemple) pour y détecter tous les organismes présents grâce à l’identification de leur génome.

Problématique d’analyse

Assemblage de novo

Consiste à assembler l’ADN fragmenté grâce au séquençage des extrémités des fragments (assemblage des reads en scafold).

Les algorithmes d’assemblage ont évolués. Avant ils repairaient les parties chevauchantes et recherchaient dans les séquences disponibles les fragments correspondants. Vue la quantité de fragments, les calculs étaient très lourds. Aujourd’hui les algorithmes parcourent des chemins plutôt que des nœuds ce qui allège les opérations. C’est le passage du cycle Hamiltonien au cycle Eulérien.

Le mapping

C’est l’alignement des fragments générés sur une séquence de référence. Pour ce faire, il est nécessaire d’avoir un génome de référence séquencé ou partiellement séquencé. On détecte ainsi les nouvelles variations de séquences qui correspondent à des SNP, INDELs… L’indexation permet d’accélérer la recherche. En principe, on découpe la séquence de référence puis on aligne nos fragments générés avec ces morceaux de séquences.
· Spaced seeds

· Burrows-Wheeler : concaténement des séquences de références ensemble.

Voir SEQanswers pour plus d’infos : http://seqanswers.com/
Problématique du stockage

En 2004, il y a apparition des NGS. Sachant que la capacité des disques double tous les 14 mois (loi de Moore) il y a nécessité de mette en place des Cyber-infrastructures (d’après Stein) pour réduire le coût de stockage et de traitement.

La plateforme SouthGreen et différents outils

Cette plateforme contient des ressources de calcul et permet le stockage de nombreuses données. 

GMOD : consortium (dont fait partie GALAXY) : Plateforme d’annotation pour les séquences ou les morceaux de séquences.
Artemis : annotation de régions génomiques

OryGenesDB : base de données riz (+ sorgho et cacao)
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Modélisation 3D par homologie

Prédiction de la structure des protéines pour mieux connaître sa fonction sans expérimentation. La modélisation en règle générale n’est possible qu’à partir de 25% de la séquence initiale. 

Cours 2 : Présentation Galaxy et TD
http://gohelle.cirad.fr/galaxy/root
Login : formation22@cirad.fr
Mdp : 22_SUPAGRO (Compte ouvert pendant un mois)
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Workflow : comme son nom l’indique, c’est un enchainement des différents outils (brique = logitiel) de manière logique pour l’analyse des données et l’accomplissement d’une tache complexe. Le workflow de galaxie utilise un ensemble de logiciels interconnecté de façon à avoir une analyse la plus complète possible. Pour les données très importantes, Galaxy limite le traitement. Grâce à un serveur de type « Apache HTTP Server », Galaxy est utilisable sur n’importe quel ordinateur. 

Pour ajouter des données, 2 moyens : 

· Get Data (taille des données raisonnable : qq Go) : à gauche

· Menu : Shared Data : Data librairies, en haut

TD d’apprentissage

Création de plusieurs historiques possibles : Option =>  create New (à droite de l’écran).
Accès à des répertoires partagés où l’on peut récupérer les données en les téléchargeant sur le disque ou les mettre dans son historique :Shared Data => Data librairies => Formation=>Début dans Galaxy => exemple.fasta (fichier contenant 10 séquences pour l’exercice). 

Destination historique => Import this datasets in the selected histories Et revennir sur le menu principal : Analyse data (Barre de Menu en haut).

Le format fasta est le format le plus simple pour stocker, lire et débugger des données séquences.

>nomdeséquence1

Séquence nucléotidique ou acides aminées 
>nomdeséquence2

Séquence nucléotidique ou acides aminées 

Changer le format du fichier : 

Pour des logiciels de phylogénie par exemple : 

TOOLS =>Convert Formats  =>Fasta2Phylip , a FASTA to Phylip file converter  => Execute

· Attention, le format strict ne tolère pas les noms de séquence supérieur 12 caractères

Format Phylip : pour l’alignement de séquences les unes en dessous des autres.

Création d’un workflow composé de deux opérations : alignement et conversion en format Phylip

Workflows(Menu à gauche en bas) =>All workflows =>Create new workflow => Name et Edit

1ère brique : On commence par un point d’entrée : Inputs => Input dataset (Menu à gauche en bas)

2ème brique : Sequence comparisons =>MAFFT , a progressive multiple alignment builder
3ème brique : Convert Formats =>Fasta2Phylip , a FASTA to Phylip file converter
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Enchainement d’outils et configuration des outils (à droite)

Option => Save

Retour à Workflow (barre de menu en haut) et Run en cliquant sur la petite flêche du workflow.

On peut introduire des séquences ou des URL séparés par des virgules : Get Data => Upload File from your computer => URL/Text

· Cours 3 : Treatment of Raw NGS Data Cleaning, Formating, Assembly, Mapping (1)

FASTQ = fasta + qualité (format existant depuis très longtemps)

Séquence paired-end : en présence d’une séquence obtenue par la technologie Illumina, on séquence les bordures. Single : dans un seul sens et paired-end dans les deux sens (forward et reverse). Dans un fichier paired-end, cette information est indiquée dans le nom de la séquence, après le # on peut avoir /1 (forward) ou /2 (reverse) pour l’un ou l’autre des sens.

La qualité est codée en code ASCII. C’est une échelle de corrélation de symboles, une manière de représenter la qualité en un seul symbole. L’ASCII est convertie en qualité Sanger et Solexa en retranchant 33 ou 64. Exemple : f = 102-64 = qualité de 38 au final : sur une échelle de 0 à 40 (entier de la probabilité postérieure que la base soit fausse).

Echelle de corrélation des symboles :

!”#$%&’()*+,-./0123456789:;<=>?@ABCDEFGHIJKLMNOPQRSTUVWXYZ[\]^_`abcdefghijklmnopwqrs

tuvwxyz{|}~

Avant on conservait beaucoup de données, on coupait à une qualité de 20, maintenant on essaye d’avoir des données fiables, on coupe à 30.


Trainings =>Data sets : raw d

 HYPERLINK "http://southgreen.cirad.fr/sites/all/files/uploads/raw_data.tar.gz"
ata
Dans Data Library => Formation => Pre-processing and Mapping 2012, on trouve 20 fichiers d’entrainement. RC : riz cultivé ; RS : riz sauvage. Fichier 1 : Forward ; Fichier 2 : Reverse. 10 individus sauvages et 10 individus cultivés.

Télécharger RS6_1 et RS6_2 par exemple.

Assemblage et mapping individuel : déterminer quel individu a quel SNP

On TAG les séquences pour faciliter l’assemblage des séquences. Le TAG est une petite séquence ajoutée à l’extrémité de la séquence p
our trouver l’enchainement de la séquence complète. Le dé-multiplexage consiste à assembler les fichiers séquence dans l’ordre et à supprimer le TAG. 

· Rappel : une profondeur raisonnable (6X est suffisant) facilite l’assemblage des fichiers.

Contrôle de la qualité : FASTQ Control

NGS: Quality Control =>FastQC quality control checks on raw sequence data

Dans le paramétrage : Contaminants: pour ajouter un fichier spécifique de contaminants : adaptateurs de séquençage, d’index…Selection is optional : pour la détection des contaminants présents dans la banque.

Résultat du FastQ control : (voir captures)

Basics statistics : Encoding Illumina 1.5 : permet de se référer à la bonne échelle de qualité.

Per base sequence quality

Courbes : bleue : moyenne ; rouge : médianes ; barres : quartiles.

Les riz sauvages ont des graphiques réguliers dus à une bonne qualité des banques. Les riz cultivés présentent des profils plus compliqués car les machines sont moins récentes et moins de séquences donc pollution en plus grande proportion.

A la vue du graphique on coupe à 7
5 car ensuite ça devient n’importe quoi (mieux vaut garder le standard et économiser du temps de nettoyage).
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Per sequence quality scores : nombre de reads en fonction de leur qualité. Le pic est artificiel (erreur introduite volontairement). Le but est de n’avoir que des séquences d’une qualité moyenne supérieure à 30.
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Per base GC content : proportion de A,T,C,G. Biais en début de séquence normal, en génomique on a pas cet effet.
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Per sequence GC content : en bleu : pourcentage par séquence si normal ; en rouge cas de notre séquence.

Per base N content : pas de N surreprésenté donc bien. Si pic de N, problème : poussière… Si le N n’est pas traité ultérieurement ce n’est pas dramatique.
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Sequence Length Distribution: 76, bon.

Sequence Duplication
 Levels : vu qu’il y a une croix une séquence est surreprésentée quelque part. Overrepresented sequences permet de voir quelles est cette séquence. 

· Attention : la Rubisco est toujours surreprésentée dans les plantes donc c’est normal. Des manip permettent d’éliminer les séquences ribosomiques.

Over represented sequences

	Sequence
	Count
	Percentage
	Possible Source

	GTTTACTTCGGGCCGATGTCCTTCAGCGCGCAGATCTGCTCCTCTCCCAT
	27
	0.6809583858764187
	No Hit


Kmer Content : donne les petits fragments qui sont ou non surreprésentés.

Formatage des données

UNTESTED TOOLS : n’a jamais tourné en production mais beaucoup d’outils pourraient être validés car très utilisés.

NGS =>Illumina data =>FASTQ Groomer convert between various FASTQ quality formats : permet le transfert d’une qualité à une autre.

Input FASTQ quality scores type: Illumina 1,3+ (dépend de la qualité de la séquence).

On exécute un Groomer sur les deux fichiers qui sont transformé forcément en qualité Sanger car le logiciel de nettoyage est en Sanger.

Visualisation de la qualité : on a plus des petits g en codage qualité mais des grands H car on est en qualité Sanger. On renomme les fichiers pour s’y retrouver :

Fichier 1 : Forward Sanger n°4 (vérifier que c’est /1)

Fichier 2 : Reverse Sanger n°5 (vérifier que c’est /2)

Nettoyage des données : apprentissage (cleaning data)

NGS: Quality Control => Cutadapt Remove adapter sequences from Fastq/Fasta

Recherche des adaptateurs au sein des séquences sur des critères de taille et pourcentage d’homologie. 

On donne une valeur d’overlap à Cutadapt. Important : Minimum overlap length: 7 (si on met plus on rate des adaptateurs, 7 bases de recouvrement et 1 base d’erreur autorisée. On a donc un taux d’erreur de 0,1%). Quality cutoff: 20 : 
coupe la séquence jusqu’à obtenir une qualité de 20. Cutadapt ne garde pas les séquences de mauvaise qualité lors de l’analyse base par base de la qualité (- 20 à chaque base) mais garde toutes les bases qui ont une qualité supérieure ou égale à 20. Minimum length: 20 aussi lorsque la taille est inférieure à 20
.

3' Adapters 1 : on rentre 10 x : 
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On obtient 2 fichier : le résultat et un rapport. Un FastQ C sur le résultat permet de se rendre compte qu’on a moins de déchets.
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Par exemple, on a plus le pic de séquence d’une qualité de 10, par contre on perd un peu de séquences.

Nettoyage des données plus fin (cleaning data)

Dans l’absolu nous n’avons aucune séquence d’une qualité inférieure à 20 mais on va fixer la qualité à 30.

NGS =>Generic FASTQ manipulation =>Filter FASTQ reads by quality score and length

Minimum Size: 35. Quality Filter on a Range of Bases : cliquer : ouvre le menu. Aggregate read score for specified range: mean of scores. Quality Score: 30.
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Pourquoi est-on passé par Cutadapt ? Pour partir avec une qualité qui est meilleure. Evite d’enlever des Reads complets qui auraient une bonne qualité en partie.

· A savoir : souvent les Reverse sont de moins bonne qualité que les Forward donc on perd plus de séquences. Ne pas oublier de renommer les fichiers !

Validation des paires (verifying data)

Concaténation des deux fichiers

UNTESTED TOOLS => Text Manipulation => Concatenate datasets tail-to-head

Datasets : Concatène plusieurs fichiers ensemble. L’ordre Reverse/Forward ou Forward/Reverse n’a pas d’importance.

NGS =>FASTQ de-interlacer on paire-end end reads

Une fois que nous avons concaténé les données, on construit les fichiers de paires. Le logiciel créait deux fichiers Forward single et Reverse single. Ensuite on concatène tout à nouveau.

On obtient 4 fichiers : 

16: FASTQ de-interlacer left mates from data 15 (Forward) : liés par paires (mates)

17: FASTQ de-interlacer right mates from data 15 (Reverse) : liés par paires (mates)

18: FASTQ de-interlacer left singles from data 15 (Forward)

19: FASTQ de-interlacer right singles from data 15 (Reverse)

Concaténation des fichiers single

Text Manipulation => Concatenate datasets tail-to-head : permet de concaténer les deux fichiers single.

Assemblage de novo (sans apriori)

Le but de cette étape est de créer une séquence à partir de plein de petites séquences. On assemble les Reads en contigs (séquence continue), reliés eux-même entre eux par une information physique de liaison en scaffold. On corrèle ensuite les scaffolds par rapport à la carte génomique. Pour certaines régions hautement répétées quelques une de ces étape sont encore impossibles (exemple : chromosome 9 du riz).Il existe aussi un autre type d’assemblage réalisé grâce à une séquence de référence (voir ci-après).

On a besoin d’un fichier qui regroupe toutes les séquences pour avoir le meilleur assemblage possible. Ici : le fichier de sortie (l’output) se nomme « 15 : Concatenate datasets Reverse and Forward ».

On utilise MIRA (ne fonctionne pas bien pour les données importantes)

NGS => Assembly => Assemble with MIRA Takes Sanger, Roche, and Illumina data

Paramètres : Assembly type: EST et Illumina dans Solexa/Illumina reads? : Yes.

On obtient les fichiers suivants : 

21: MIRA contigs (FASTA) : assemblage de tous les reads

22: MIRA contigs (QUAL) : on peut éliminer sur la qualité : tient compte de la profondeur et de la qualité des bases à cette profondeur.

23: MIRA contigs summary

24: MIRA contigs stats : nombre de contigues, nombres de reads pour les constituer (si très élevé peut être à l’origine de séquence ribosomiques), qualité, % GC…

25: MIRA contigs (CAF) : format d’assemblage

26: MIRA contigs (ACE) : format d’assemblage

27: MIRA log : vérifie la qualité du travail, donne des informations sur le mapping

Si on renouvelle l’opération, les résultats seront différents à cause du changement de la position de démarrage.

Remarque sur les assembleurs NGS : 

· On ne peut pas assembler les séquences sur un cluster en tant que tel, on peut assembler ces séquences que sur une mémoire unique car les informations doivent être toutes accessibles….cette étape d’assemblage est longue et nécessite beaucoup de place (96 Go de mémoire vive à l’IRD et CIRAD !)

· Mécanisme d’assemblage : agrégat  en fonction de l’endroit de point de départ ce qui va changer le résultat si on recommence cette étape. Sauf lorsque les séquences sont nombreuses : assemblage plus long mais de meilleure qualité. 

Blast

On fait un blast sur les séquences de références que l’on compare à l’EST Rice.

Sequence comparisons => BLAST+ blastn (MC) Search nucleotide database with nucleotide query sequence(s)
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Le fichier de sortie contient entre autre : le nom, le pourcentage d’identité, la longueur sur laquelle on a une identité, les mismach, la I-value (probabilité d’avoir cet alignement dans une seule séquence (donc non comparable)), le score.
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fie o | HERFGTGENDFRF HGHNNHHGHF KHF P FAF A B

Crevale o m o [l s | TR O X
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BWA will not search for suboptimal hits with a score lower than [value]
Gap open penalty (-0):

i1

Gap extension penalty (-E):

B

Proceed with suboptimal alignments even if the top hit is a repeat:

r

By default, BWA only searches for suboptimal slignments if the top hit is unique. Using this option has no effect on scouracy for single-end reads. Itis
mainly desined for impraving the alignment accuracy of paired-end reads. Hawever, the pairing pracedure will be slawed dawn, especially for very shart
reads (~32bp) (-R)

able iterative search:

o

Al hits with no mare than maxDiff differences will be found. This made is much slower than the default (-N)

Output top [value] hit:

E
For singls-end reads only. Enter -1 to disable outputting multiple hits. NOTE: If you put in a positive value here, your output will NOT be in SAM format
-n)

Maximum insert size for a read pair to be considered as being mapped properly:

500

For paired-end reads only. Only used when thers are ot snough good slignments to infer the distribution of insert sizes (-a)

Maximum occurrences of a read for p
100000
For paired-end reads only. A read with more occurrences will be treated as  single-end read. Reducing this paramster helps faster pairing (o)

Suppress the header in the output SAM file:
~

BWA produces SN with severs! lines of header information

Execute

What it does
BWA s a fast light-weighted tool that sligns relatively short sequences (queries) to a sequence database (large), such a5 the human reference genome. It is

developed by Heng Li at the Sanger Insitute. Li H. and Durbin R. (2003) Fast and accurate short read alignment with Burrows-Whesler transform.
Bioinformatics, 25, 1754-60.

Know what you are doing
A .

| 53 2awodle optionnel

| s Formati Hor.. || @ Gty - Mot Fiefan

History (Options ~ |

ve

Unnamed history

I:u referencefastst @ [ X
I 30: meqablastonfile ® § %

29; ®JR
Oryza sativa.MSU6.cdna.all.fa

28: meqablastondb = ® § R
27: MIRA log @0 R

Izs: MIRA contigs (ACE) ® § R
Izs: MIRA contigs (CAF) ® § R
I 24: MIRA contigs stats ® § %

®0%

23: MIRA contias
summary

22: MIRA contias @I
(ouaL)

21: MIRA contigs @I
(EasTA)

20: Concatenate @R
datasets on data 19 and data
18

19: FASTQ @R
de-interlacer right sinales from
data 15

18: FASTQ @I
de-interlacer left sinales from
data 15

J— -
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= rmdup remave PCR
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PICARD TOOLS
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Fichiers SAM
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UNTESTED TOOLS

Text Manipulation
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e oB

Unnamed history

38: Sortsam avec 5AM ® ) R
avec single

37: 5AM avec Single @ § %

35: Sortsam avec 5AM @ ) R

avec Paired

34: 5AM avec Paired @ ) R

I 33: Map avec Single @ § %

32: Map avec Paired @ ) R

31: referencefastst @ [ X

I 30: meqablastonfile ® § %

2 @R
Oryza sativa.MSU6.cdna.all.fa

28: meqablastondb = ® § R

27: MIRA log @0 R

Izs: MIRA contigs (ACE) ® § R
Izs: MIRA contigs (CAF) ® § R
I 24: MIRA contigs stats ® § %

23: MIRA contias @I
summary

22: MIRA contias @I
(ouaL)

21: MIRA contias

@R
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e e mira ol Pooida OryzaS|CI315126|Oryza  82.78 97 7 o lese 1932 1 57 22: MIRA contias YRS
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Blast est un outil statistique !

Pour comparer avec la séquence de Riz de la librairie on utilise les outils suivants : Shared Data => Data libraries => Reference transcriptome Riz
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BLAST+ blastn (MC)

= BlastClust , 3 blast-based
clustering method

e oB

Unnamed history

I 30: meqablaston file ® { %X

29: @R
Oryza_sativa.MSU.cdna.all.fa

Nucleotide query sequence(s):
ZL: MIRA contigs (FASTA)

Subject database/sequences:
FASTA file

= UClust , a seed-based
clustering method

= BLAST+ blastn (MC) Search
nucleatide database with
nucleotide query sequence(s)

Nucleotide FASTA file to use as database:
25 Oryas_sativa MSUs dna ailfa ]

= BLAST+ blastp (HC) Search
pratein database with protein
query sequence(s)

= BLAST+ blastx (NC) Search
protein database with
translated nucleatide query
sequence(s)

= BLAST+ thlastn (MC) Search
translated nucleatide
database with protein query
sequence(s)

28: meqablastondb @ § X
Type of BLAST:
@ megablast

© blastn

© blastn-short
© de-meagablast

27: MIRA log @0 R
6: MIRA contigs (ACE) ® { %
5: MIRA contigs (CAF) ® ( %

Set expectation value cutoff:
pet expectation 24: MIRA contigs stats ® )

il

0.001
= BLAST+ thlastx (MC) Search
translated nuclestide Output format: 23: MIRA contigs ®0%

summary

database with translated
nucleotide query sequence(s)

Tabular (standard 12 columns) =]
Advanced Options:

Hide Advanced Options x]
Execute

) Note, Database sesrches may take a substantial smount of fime. For lsrge input dstssets it is advissble to sllow overnight processing

22: MIRA contigs @I

- NCBI BLAST+ blastn Search
NCBI BLAST+ blastn (ouaL)

nucleatide database with
nucleotide query sequence(s)

21: MIRA contigs @I
(EasTA)

= NCBI BLAST+ thlastx Search
transiated nudleatide.
database with translated
nucleotide query sequence(s)

20: Concatenate @R
datasets on data 19 and data

What it does A

UNTESTED TOOLS
Search a nuceotide database using a nucleotide query, using the NCEI BLAST+ blastn command line tool. Algarithms include blastn, megablast, and

‘ext Manipulation
frest Hantoulat discontiguous megablast.

lter and Sort
Join, Subtract and Group
Convert Formats

19: FasTO ®0%
de-interlacer right sinales from
Output format data 15

Because Galaxy focuses on processing tabular data, the default output of this tool is tabular. The standard BLAST+ tabular output contsins 12 columns: 18: FASTO @0 %

de-interlacer left sinales from
data 15

Estract Features
Fetch Sequences
Fetch Alignments

[Column[NCET name[Deseription
0 laseaid___|Query Seq-id (ID af your sequence)

Operate on Genomic Intervals 2 sseqid _[Subject Sea-id (ID of the database hit) 17: EasT 7
sta = pident __|percentage of identical matches JLEasto Rt 0%

e-interlacer right mates from
Feanh Misnlaw Nata o length [alignment fength PR
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BLASTX : comparaison de séquences nucléotides à des séquences protéiques.On peut utiliser Phred/Phrap comme assembleur. 

Faiblesses de Galaxy

Noms des fichiers

Pas d’accents au niveau des noms ni de caractères spéciaux.

On ne renomme pas les fichiers lorsqu’ils n’ont pas fini de tourner.

Assembleurs NGS

On ne peut assembler que sur une mémoire unique (une seule machine).

Workflow

On ne peut pas lancer un Workflow en boucle.

On ne peut pas copier un Workflow.

· Cours 4 : mise en perspective, workflows et traitement de données NGS

Le séquençage est en route : sur le support de cours, on a en vert les séquences publiées et en bleu non publiées. 

Va-t-on réussir à réunir un consortium suffisamment important pour réaliser un travail aussi performant sur d’autres espèces que sur ce qui a été réalisé sur le riz ?

Les instituts de recherche asiatiques vont tout séquencer ! Les données privées vont-elles le rester longtemps ?

Notion de qualité du séquençage : garder un œil critique sur le matériel utilisé et mis à disposition dans les bases.

Comparaison de quelques données

Certaines données sont plus mauvaises que d’autres : 

· 454 : plus cher, plus difficile à assembler.

· Pacific Bioscience attendu car aura les mêmes défauts de séquençage que le 454 mais avec des longueurs de séquences beaucoup plus importantes. Permet d’avoir des fragments espacés. Méthylome (étude de la méthylation de l’ADN). 

· Ion Torrent (même type d’erreur que le 454 mais moins cher) et MSeq (technologie Illumina et fonctionne bien) : usage quotidien abordable, pour du génotypage par séquençage.

NGS : Déluge de données

Cloud-computing : machines reliées ensembles  et traitement des données avec les ressources des particuliers ce qui pose un problème de confidentialité des données.

Limite des clusters : volume des données, stockage et traitement impossible.

Problématiques nouvelles

Le phénotypage, une étape limitante et chère de plus, en pathologie par exemple, il dépend de l’observation humaine des symptômes : faisabilité à haut débit?

Acquérir de nouvelles compétences dans le domaine de la bioinformatique.

Outils intégrés : exemple de Galaxy

Problèmes des formats de fichier

Avantage des workflow. 

· Cours 5 :Treatment of Raw NGS Data Cleaning, Formating, Assembly, Mapping (2)

Création d’un fichier de mapping (SAM)

Il s’agit de placer les paires ou les singles sur une séquence de référence. Dans le cas des paires on a deux séquences, le forward et le reverse. Le logiciel place toutes les positions potentielles du forward et toutes les positions potentielles du reverse et choisi ensuite selon les critères suivant la meilleure position (en rouge, position refusée, en vert, position validée) : 

· F et R doivent se faire face

· Séquence entre les deux limites extrêmes de 300 à 500 bases

On va donc calculer les positions pour chaque reads, évaluer les relations entre chaque membre d’une paire et sélectionner la position la plus probable => Fichier SAM

Si la position des Forward et des Reverse est inconnue, le logiciel va proposer la position la plus probable (en générale si il n’y a pas de positionnement possible des séquences Forward et Reverse c’est qu’il y a eu insertion d’un élément transposable ou qu’il y a eu une recombinaison qui a abouti à une délétion). 

Mapping: NGS : Mapping => Map with BWA for Illumina. Paramètres : Select a reference from history: Fichier de référence : Shared Data => Data libraries =>Formation => SNP => référence fas.txt. Maximum Edit distance (-n) : si les séquences font toutes la même taille on donne un chiffre si non on peut donner une fraction qui autorise les mismatch. Disallow: Autorise-t-on ou pas les longues délétions dans les 16 dernières bases ? Disallow : De même dans les 5 premières bases. Mismatch penalty (-M) : Combien de point coute un mismatch ?
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Map with BWA

will you select a reference genome from your history or use a bt

Use a builtin index =]

Select a reference genome:

OSativa_transcriptome <]

Is this library mate-paired?:

Single-end =]

FASTQ file:

20: Concatenate datas..and data 18 =

Must have Sanger-scaled quality values with ASCIL offsst 33
BWA settings to use:

Full Parameter List =

For most mapping needs use Commonly Used settings. If you want full control use Full Paramster List

Maximum edit distance (-n):
o
Enter this value OR a fraction of missing alignments, not both

Fraction of
004
Enter this value OR maximum edit distance, not both

ing alignments given 2% uniform base error rate (-n):

Maximum number of gap opens (-0):
0

Maximum number of gap extensions (-e):
1
1 for k-difference mods (disallowing long gaps)

allows long deletion within [value] bp towards the 3'-end (-d):
6

allow inser
g

n/deletion within [value] bp towards the end (

Number of first subsequences to take as seed (-1):
E

Enter -1 far infinity

Maximum edit distance in the seed (-k):

2
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I:u reference.fastst @ { X
I 30: meqablaston file ® { %X

29: @R
Oryza_sativa.MSU.cdna.all.fa

o

28: meqablastondb @ § X

27: MIRA log @0 R

I 26: MIRA contigs (ACE) ® { %
I 25: MIRA contigs (CAF) ® { %
I 24: MIRA contigs stats ® { %

23: MIRA contias ®0%
Summary

22: MIRA contigs @I
(ouaL)

21: MIRA contigs @I
(EasTA)

20: Concatenate @R
datasets on data 19 and data
18

19: FASTQ @R
de-interlacer right sinales from
data 15

18: FASTQ @I
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data 15
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	Maximum edit distance (-n)
	Distance réelle ou % de distance : si les séquences sont de taille différentes : combien de miss match

	Maximum of GAP open
	

	Maximum of GAP extentions
	Extension maximum des Gap

	Disallow long deletion within [value] bp towards the 3'-end (-n)
	Autorisation des longues détections dans les 16 dernières bases

	Disallow insertion/deletion within [value] bp towards the end (-i)
	Combien d’Indels : interdire les grand Indels ou autorisation long Indel (simulation intron)

	Number of first subsequences to take as seed (-l)
	Les x premières sous séquence sont des graines, si pas de taille de graine attribuer, plus long

	Proceed with suboptimal alignments even if the top hit is a repeat
	Propose des alignements

	Disable iterative search
	La première fois qu’il va trouver une séquence il ne va pas les chercher ailleurs

	Output top [value] hits:  en single end
	Position les plus probables

	Maximum insert size for a read pair to be considered as being mapped properly
	Taille max

	Maximum occurrences of a read for pairing
	La structure en verre on peut la retrouver jusqu’a 100000 fois.

	Suppress the header in the output SAM file:suppression du header (donne sur quoi on a mapper),
	Comporte les informations diverses tel que : qui a fait la manip, avec quoi…


Dans le fichier SAM les données sont triées par coordonnées
. Ref LNpour length : longueur de la séquence de référence. Il s’y trouve le code reverse/forward, la référence de départ, la qualité puis le CIGAR string (représentation d’un alignement avec des codes beaucoup plus simples, ex : 9M=9 misma
tch ; I = insertion, H = mauvais alignement…). Avant la séquence on a le point de démarrage du mate et la distance (39 ;-39 sur la fiche) et après la séquence : le nombre de mismatch
 réel. 

Lorsque le fichier sort et qu’on n’a pas trié il n’y a pas d’information de sort order.

ID:bwa
PN:bwa
VN:0.5.9-r16 (programme et version utilisée)

Dans tout les cas, la notice est présente sur http://bio-bwa.sourceforge.net/ dans SAMtools par le lien SAM Spec v1.4
NGS: SNP Detection => SNiPlay Utilities => AddReadGroupIntoSam Add read group into a sam alignment

Nettoyage des duplicata techniques

Consiste à éliminer les séquences répétées ou liées aux deux extrémités sur la plaque (erreurs de séquençage). On réalise deux nettoyages à partir des fichiers BAM, un avec le fichier paire-end et l’autre avec le fichier single. On construit ensuite deux fichiers BAM avec SortSam en changeant le fichier de sortie. Le fichier BAM est plus compressé et plus rapide à traité.

NGS: SAM/BAM Manipulations => rmdup remove PCR duplicates

On fait un rmdup avec le fichier Paired-end. On peut aussi choisir de le traiter en single pour qu’il ne traite qu’un coté. Le rmdup permet d’alléger le fichier en enlevant les duplicata techniques. 

Fusion des deux fichiers

Ancêtre Oriza sativa, O. barti. On fusionne grâce aux commandes suivantes :

NGS: SAM/BAM Manipulations => MergeSam Fusionner des fichiers SAM/BAM

Conversion des fichiers :

NGS: SAM/BAM Manipulations => SAM-to-BAM converts SAM format to BAM format

NGS: SAM/BAM Manipulations => BAM-to-SAM converts BAM format to SAM format

Partage des fichiers

Option de l’historique => Share or publish =>Makes the history accessible via link

Récupérable sous le lien proposé : http://gohelle.cirad.fr/galaxy/u/formation22/h/unnamed-history
Ou par Shared Data et dans Published Histories

Création du workflow

Workflows => All workflows => Switch to workflow management view => Create new workflow => Edit

Pour introduire des données : Workflow control => Inputs => Input dataset

Faire apparaitre la boite Cutadapt : NGS: Quality Control => Cutadapt Remove adapter sequences from Fastq/Fasta

En cliquant sur les étoiles présentes dans les briques on peut demander au workflow de sortir des données intermédiaires

Le Search Toolest un outil qui permet de rechercher des briques dans le menu de gauche. 

Sum up du mapping (sans assemblage)

Pour un individu nous avons fait (entre parenthèses : nombre de briques) : 

FastQ Groomer (*2)

Cutadapt (*2) : reprendre les réglages

Filter FastQ (*2)

Concatenate (*1)

FastQC (*1)

Deinterlacer (4 fichiers en sortie) (*1)

Concatenate single

BWA (*2)

ReadGroups (*2): ne pas faire d’autodétection

SortSAM (*2)

RMDUP (*2)

MergeSAM(*1) : on rentre et sort en BAM
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Cours 6 : Recherche et analyse de polymorphisme SNP (TP)

Un polymorphisme SNPest un polymorphisme qui s’observe sur une seule base. On va essayer de le détecter à partir d’un mapping au format SAM. Il existe un code IUPAC pour qualifier la variation des nucléotides. Exemple : pour la variation T/G=K.

Mise en marche de Tablet

Cette interface permet la visualisation d’assemblage de données NGS. Il accepte différents formats: ACE, SAM, BAM.

Accès à Tablet : http://bioinf.hutton.ac.uk/tablet/faq.shtml
Ouverture du Java web Start sur un lien du site (http://bioinf.hutton.ac.uk/tablet/webstart/tablet.jnlp.)

Tablet s’ouvre alors dans une fenêtre à part.

Pour permettre à Tablet de charger l’assemblage celui-ci doit être préalablement trié par positions sur la référence. Pour ce faire, on créé un nouveau fichier d’assemblage trié grâce à la brique Galaxy suivante (fichier séquence) :

NGS: SAM/BAM Manipulations => PICARD Tools => SortSam Trie les entrees des fichiers SAM

On récupère deux fichiers sur le disque que l’on ouvre sur Tablet :

· SortSam_on_data_24.sam (fichier séquence)

· reference.fas.txt.fasta (référence)
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Read Packing : changer le mode d’affichage. Permet de représenter une ou plusieurs lectures par ligne. 
Read Colours : Read Group par exemple pour trier par groupes. Ci dessous : flêche blanche : un read et flèche noire un hétérozygote.
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Pour une détection automatique des SNP, 3 options sont disponibles dans Galaxy SouthGreen: 

· SamToFastaAlignments

· VCFToFastaAlignments

· VarScan

Logiciel Varscan

Logiciel de détection de SNP à partir de fichier Pileup : Pileup2snp
Lecture d’un fichier Pileup

En prenant l’exemple qui figure sur la support de cours, on obtient : 
seq1 272 T 24  ,.$.....,,.,.,...,,,.,..^+. <<<+;<<<<<<<<<<<=<;<;7<&
=>24 : Profondeur de 24 lectures en position 272 de la sequence seq1
=>,.$.....,,.,.,...,,,.,..^: Variations à cette position. Dans cette exemple, aucune variation.
=><<<+;<<<<<<<<<<<=<;<;7<&: Qualité à cette position
Construction d’un Pileup

Pour utiliser le logiciel, constituer un nouveau fichier Pileup sur Galaxy grâce à la brique suivante :

NGS: SAM/BAM Manipulations => SAM Tools =>Generate pileup from BAM dataset

Puis identification des SNP par la brique suivante :

NGS: SNP Detection => VARSCAN => Pileup2snp Identify SNPs from a pileup file

Paramètres : Minimum variant allele frequency threshold : 0,05

On obteint deux fichiers : un fichier stats dans lequel on a le nombre de position qui respectent la position et les prédiction de SNP sur l’intervalle : ici 27 SNPs predicted.

Et un fichier SNP dans lequel on a les informations suivantes : la position de la variation, la séquence référence , la séquence consensus, information du nombre de fois ou l’on retrouve l’allèle de référence et l’allèle variant.

Librairie GATK

Librairie logicielle pour l'analyse de données NGS.
Un premier module appelé IndelRealigner permet de réaligner autour des insertions/délétions afin d’optimiser l’appel ultérieur de SNP :
NGS: SNP Detection => GATK =>IndelRealigner Realign around indels in BAM format

On obtient 3 fichiers de sortie :

· BAM output : utilisé pour l’appel de SNP

· Intervals

· Log

Estimation des ressemblances entre génotypes

NGS: SNP Detection => GATK => UnifiedGenotyper Unified Genotyper

On obtient en sortie un fichier de SNP au format VCF (Variant call Format)
· VCF output : « REF » , position sur le référence, allèle de la référence, allèle variant, qualité de SNP, « FILTER » filtre de qualité indiquant si la qualité est bonne ou non : « Lowqual » : elle ne respecte pas les paramètres établis ici à 30, « RC1 » : information concernant l’individu RC1.
Dans les colonnes individus on trouve les informations suivantes : 0/1:1,1:2:33.99:34,0,34 (en rouge signifie hétérozygote, le / signifie qu’on a perdu la phase avec le précédent, si 0I1 on reste en phase, en vert la profondeur du 0, en bleu la profondeur du 1, en violet, la profondeur totale).Avantage de GATK à Varscan : avoir un fichier global avec tous les individus et assigner les allèles aux génotypes.

On peut utiliser d’autres modules :

· Module DepthOfCoverage:

Permet de renseigner la profondeur de séquençage pour chaque gène, chaque position et chaque individu.

· Module ReadBackedPhasing:

Permet de définir dans la mesure du possible les associations d’allèles (phase ou haplotype) quand il y a hétérozygotie.

Lancement des modules supplémentaires

Depth Of Coverage

NGS: SNP Detection => GATK => DepthOfCoverage Depth Of Coverage

On obtient 2 fichiers de sortie :

· Depth of coverage : nom du gène, valeur de profondeur pour chaque individu, profondeur globale et moyenne. Quand on a que des zéro ça veut dire que ce n’est pas couvert par les reads.

· Fichier de Log

L’avantage de Depth of Coverage et qu’il permet de savoir si on a une donnée manquante ou un invariant.

	0I1

0/1
	Non phasés

	0I1

0I1
	Phasés


Read-backed phasing algorithm

NGS: SNP Detection => GATK => ReadBackedPhasing Read-backed phasing algorithm

On obtient 2 fichiers de sortie :

· 14: VCF output : présente cette fois-ci des séparateur pipe à la place des slash pour associer les allèles et dire qu’ils sont sur les même reads. Identification des haplotypes ? As t-on pu associer deux positions hétérozygotes l’une avec l’autre ? Recherche avec Tablet. On peut ouvrir ce fichier avec Excel et rechercher un individu pour lequel on reste en phase sur une certaine distance : association des allèles 1 avec 1 et 0 avec 0. C’est une information physique : les variations peuvent être phasées uniquement si elles sont sur le même read. 

· 15: Log

Application SniPlay
http://sniplay.cirad.fr
SNiPlay est téléchargeable et peut être installé sur un serveur.

Dans la barre des menus aller dans Pipeline for SNP Analysis. Entrer les bons fichiers (voir ci-contre).

Sélectionner les individus avec la double flèche.

Avec la méthodologie utilisée on a 70 à 80% de vrais SNP. La profondeur est un bon indicateur de véracité. 
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Quel fichier serait-il possible de soumettre à Illumina pour designer des puces SNP (technologie VeraCode) sur l’ensemble des gènes?

Voir onglet 3.2 Files : Illumina_submission.txt : donne les SNP et les positions flanquantes. 

Phasing : reconstruction d’haplotypes

Attention pas de système d’historique, il faut enregistrer les fichiers !

On refait une analyse en ne passant que les individus séquencés sans la référence (attention il faut quand même la charger). Pour cela on ne la sélectionne pas avec la double flèche (dans Accession selection). 

Un SNP n’apparaît plus. C’est un SNP asiatique et il n’apparaît plus sachant que nous avons que des séquences africaines.

Avec les données accessions

On peut aussi ajouter des informations sur les accessions dans la partie commentaire. On peut ainsi avoir des renseignements sur la liste des SNP de chaque compartiment, ceux spécifiques aux individus sauvages et ceux spécifiques aux individus cultivés. Dans l’onglet Phasing se trouve la répartition des haplotypes au sein de chaque compartiment. Dans le network se trouve aussi une représentation en camembert des individus sauvages et cultivés.

L’onglet diversité présente un plot des valeurs de D de Tajima (culitvé vs sauvage). Pour rechercher des gènes soumis à une sélection positive par la domestication, on peut rechercher des valeurs négatives chez les cultivés et positives chez les sauvages. Quand on a une masse de gènes on va regarder ceux qui ont été potentiellement sélectionnés. Permet de repérer facilement les grosses différences entre compartiments.

Sump up de la journée

Au départ, on avait un fichier brut NGS. Nous avons nettoyé les séquences pour obtenir des fichiers propres. Nous les avons ensuite assemblés en contigs pour rassembler l’information fragmentée en une information globale. A partir de ces contigs on peut procéder à une annotation fonctionelle ou faire un mapping contre uneréférence si on dispose d’un jeu de référence.Dans le cas où on ne dispose pas de référence, on procède à un assemblage de novo. 
Applications des SNP détectés : 

· déterminer des marqueurs d’intérêt (liaison avec le phénotype)

· puce de génotypage SNP (48 SNP minimum) pour génotyper sur plus d’individus

· cartographie génétique

· analyses d’évolution

· génétique de populations…
La profondeur minimale pour valider un SNP est de 10X(Soit un SNP sur au moins 10 reads) Attention à la mapping quality = 0 ce qui signifie que la lecture a été mappée à plusieurs endroits sur la référence(ex : gènes dupliqués, paralogie) donc on ne peut pas accorder de confiance en une mapping quality de 0. L’idéal est d’avoir une profondeur de base la plus élevée possible pour pouvoir évaluer la fiabilité du SNP.

Y a t-il d’autres informations exploitables ? Oui, les INDELs (GATK), larges variations, transloccation, deletions… avec Variation hunter par exemple. 

Cours 7 : Basic notions in Annotation Exemple of transposables elements

Deux temps : 

· Introduction basique sur l’annotation (exemples avec les éléments transposables)

· Utilisation d’ARTEMIS

Quelques mots au sujet des éléments transposables qui sont des structures à prendre en compte lors de l’analyse des génomes. Exemple du riz (Oryza sativa). Il en existe plusieurs types (pour plus de détails, voir le support de cours) :

· LTR (en bleu) commence par TG et finissent par CA (l’extérieur), en rouge TSD, en orange GAG et en jaune POL. 

· SINE : impliqués dans l’évolution, notamment dans la différenciation des primates supérieurs.

· TIR : présence d’une transposase : couper/coller. 

· Helitron : possèdent une hélicase. Copie de l’ADN dans un nouveau locus sans passer par l’ARN. Capables de générer de nouveaux gènes.

· [image: image22.emf]Class Order Superfamily Family Code / Label
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LTR, long terminal repeat;

LINE, long interspersed nuclear element;

SINE, short interspersed nuclear element;

TIR , terminal inverted repeat.

MITE, Miniature Inverted Transposable Element
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Plusieurs outils de comparaison des génomes

· - BLAST + Specific DB

· - RepeatMasker : http://www.repeatmasker.org/ 

· - Censor : http://www.girinst.org/censor/ 
· - PlotRep

· - Dotter (efficace mais un peu lent) / Gepard (très facile à utiliser) : il s’agit de comparer la séquence à elle-même. On obtient des structures caractéristiques des LTR (1) et des TIR (2) par exemple.

D’autres outils pour laprédiction des structures

· LTR_STRUC (à l’échelle du BAC) ; LTRharvest (donne des éléments de structure intéressants) ; LTR-finder : facile à installer et capable d’analyser des génomes entiers.

· RepeatScout ; RepeatFinder : fonctionne bien pour les LTR mais moins bien pour les classes 2 et pas du tout pour les hélitrons.

· REPET : Pipeline qui reprend les résultats et établi une qualité en fonction de la répétabilité.

L’outil Artemis

C’est un outil pour visualiser et annoter petites et grandes séquences. Deux grandes écoles : ARTEMIS (open source et facile à utiliser) et APOLO. 

Artemis permet de mener les actions suivantes : 

· Structure prediction

· Protein detection

· Nucleic detection

· Merging

· TSD : typique d’un clivage de la double hélice. Les mécanismes de réparation vont répliquer les homologues des nucléotides face au manque induit par l’insertion. 

· Nesting : insertion dans une insertion (empilement d’éléments transposables). 

Présentation : une fenêtre (n°1) d’annotation globale : en haut brin +, en bas, brin -. Une fenêtre (n°2) de vue détaillée et une fenêtre (n°3) de features.

[image: image23.png]¢ Artemis Entry Edit: 0s01_36429_36558.fna =18 x|

File Entries Select Viev Goto Edit Create Run Graph Display

Selected feature: bases 181 BLASTCDS (/blast_score= 264 /score=93.37 /percent_id=93.37 /query id=0s_l:36423001..36558000 /subject, start=2655 /subje

Encr: Mon fichier

FENETRE 1

D 13
BLAS BI. BLAYTEDS BLAsTODS BLasTODS
BLasTODS
lisa a0 |sooo s |ssoo  lsoaso  fsiaon  |seoos  fsaswo  |sseos  [saao  |asaos  [ssooo  |sswoo  lsmeoo  |ssaro |
= = — — a a -
BLASTCDS ASTODS BLAS B BLAST( BLASTCDS BLAsTODS BLAsTODS  BLasToDs BLASTODS

il T I I

P M T D o s 5 K5 6T FD P LHAEGLTEGTOVYYVCYCETERERRGQTOCANEU NN GG+ TSV YLCSTHDLSISTLAS
4 "+ T AAAS QERLILECTORGYLRNYERCTCYUEEQRGDEDRLEGUSG  tHEG v HTTcaveRalA
Ao TGS CAATEAGSAAC T oA T CTCT6 AT G AGA ST TTACCAATEGTA GO TOTAC S TEToTO TGO ACARACACAGAGCAGACCAGGACAGACTO A AT AT ATGAAT GGG TAGACAAGTOTOTATITATO TG AACACACGTITGTCANTATCEACOTTAGCTAGEAA
o o leo Jso [ [ [ [ Jiso [
A TATE TG T AT TC T CAAACTA B AC A TOC S TC T CAG AN TTACCATECCACATO A AC A AT T IO e T T o TEAC UG TTACCTEA A TTACETCCEATC TS TTCACACATARKTACACC TS TO TS TAAEAGTTATAGSTECAKTEATEGTT
LS LR CCCTLFTODESARLPDSSHTPTRTHDLELSSVLYSQLLETS S HLTSLETHELEEYRNTLIUTL S

. IIs?PLLLDPYVYNSGCRCASP?RYFPYVYTYTHTP?SYSLLRPCYPATISHTIFPP?YYVLTYEKEHEPYCSEKDIDYUNALL
U H YUV AAAL®SREIRGQYVCLTERRITRHYHTHSFCL?PSSSLSSCHLEPHIS?PLCTHIS$TSCY IQ*YG6RESAR

M sLasTODs 128629 128665

o hit 5 st G212 o178 50,1 pereens 0s 91,69
Woiioros  139co0 Lovass ¢ v o oquiq 5952, 3508 5001 pereens 10t 2168
BIASTODS  Looeap Minees & it te DRSATETIODTIGISD ddie. 2901 scens: A1 percenc
Woiiorios 139000 156000 ¢ v o CROVTETIOUTODLIS 0021, c1aL ssores 264 pereent FENETRE 3
BIASTODS 206D 139000 & it te DRSATETIODIONIDS Sio. 2906 seere 204 percemt
Woiiorios 139020 15900 ¢ v o CROVTERTOUAOOMS odns. 235 ssores 264 pereent
Blastons Leean dzanoo ¢ oA TERD0Z 00163 Lo 41055 ses:

BLASTCDS 128820 129000 ¢ hit to ORSLTERTO0Z000L
M 5LasTCDS 128820 129000 ¢ hit to dagul 2408..2228
BLASTCDS 128820 129000 ¢ hit to dagul 11963..11783 score: 264 percent id: 93.37 668
M 5LasTCDS 128820 129000 hit to carre 18058..l8238 score: 272 percent id: 93.92 3e-70

BLASTCDS 4199 4610 hit to ORSQOTOTOOOO4SS 240..652 score: 420 percent id: 88.22 e-value: Se-llS
M sLasTCDS 28971 32453  hit to ORSQTERTOOTOO0S3 2179..12847 score: 333 percent id: 8L.3L e-value: 8e-89

12275 score: 264 percent id: 93.37
264 percent id: 93.37 e-value: 6e-68

Kaim ]

Woémarrer| |3 @ @ 5 @ | G | [Wnotesfomationb... | @ Formaton (04-051...| (5 Ziodle option..| (& notation trans... | @) Télichargements | § atemis Release 1., [ § artemis Entry E. artemis Featur=E... | [) () @ @ 105





Ouverture du logiciel : SSH File manager : permet l’ouverture d’un serveur à distance. Sinon : Open pour ouvrir un fichier présent sur le disque. La séquence (.fna) apparaît avec tous les codons stop. Avec File => Read an entry, on lance la lecture du fichier de repeat (.fna.repeat). Ces séquences correspondent à des résultats de BLAST. Bloc rouge : le BLAST trouve une structure qui correspond à des repeat (BLASTX alors que c’est du BLASTN).

Clic droit, décochage Stop codon, One ligne per entry, All feature one frame line : permet d’avoir tous les types d’annotation sur la même ligne. On ne travaille jamais sur les séquences d’ouverture, pour cela, on créait une nouvelle ouverture Create => New entry. Enregistrement de No name (nouvelle entrée). Suivre les étapes sur le support de cours. 

Creation d’un feature

Create =>New feature. Code de longueur (location) : START..STOP. Dans la grande fenêtre, on nomme la séquence, un bloc vert apparaît.

Commandes :

Zoom : ascenseurs côté droit.

Fenêtre 1 : 

Sélection base range : cliquer/tirer.

Ctrl + C : create a new feature : ajouter un LTR ou ce qu’on veut, il suffit de changer la clé.

Ctrl+flèche gauche ou droite pour se balader sur la structure.

Pour copier une entrée de la notation BLAST à mon entrée : Clic droit sur une structure => Edit =>Copy selected feature to…

Une fois que deux structures sont sélectionnées : Ctrl + M pour les relier (merge).

La fonction merge est impossible si les élémentsn’appartiennent pas à la même catégorie ou si les sens sont inversés ou encore si on a un gène au milieu (les gènes ne sont pas dans des éléments transposables). 
Clic droit sur la structure => Smallest feature Front : faire apparaître la plus petite structure devant (afin de pouvoir la sélectionner par exemple). 

Pour visualiser les codons stop, déselectionner One Line per Entry (clic droit).

Ctrl + E : ouvre la fenêtre d’édition

Touche Complement : switch d’un brin à l’autre

Fenêtre 3 :

Double clic sur le feature pour obtenir sa visualisation en fenêtre 1.

Advance mode : export de l’image

Gepard

Sélection avec la souris de la zone à agrandir et Update dotplot
Structure caractéristique d’un LTR.

Cours 8 : Prédiction de la structure 3D d’une protéine – modélisation moléculaire par homologie et threading
Les protéines sont structurées en différentes sous-structures : 

· Structure primaire : séquence (chaîne polypeptidique)
· Structure secondaire : repliement local (notamment hélice alpha et feuillet beta)

· Structure tertiaire : conformation tridimensionnelle 

· Structure quaternaire : organisation multimérique (assemblage de plusieurs chaînes polypeptidiques)
· Structure supramoléculaire : assemblage à large échelle des protéines avec d’autres types de molécules
La structure 3D régit les interactions protéine/protéine, (ex : anticorps/antigène, protéine/récepteur), protéine/acide nucléique (ADN, ARN), protéine/autre ligand (ex : lipide, membrane, etc.), . La connaissance de la structure d’une protéine permet d’appréhender ses mécanismes fonctionnels.
Problématique : On a une séquence en acides aminés (au format FASTA)…


>myprotein
MAPAAHRDGAAEAVGQRVFHFGKGRSDGNKTMKDLLGGKGANLAEMASIGLSVPPGFTVSTEACQQYQAQKAMPAGLWDEILAALTWVEGNMGAVLGDPRRPLLLSVRSGAAVSMPGMMDTVLNLGLNDHVVAGLAHRSGERFAYDSYRRFLDMFGNVVMDIPHSLFEEKIEAMKAALGLRNDTELTARDLKELVAQYKNVYVEAKGEEFPSDPKKQLHLSVLAVFNSWDSARAKKYRSINQITGLKGTAVNVQCMVFGNMGDTSGTGVLFTRNPSTGERKLYGEFLVNAQVQIYRGEDVVAGIRTPQDLDTMKDCMPEPYAELVENCKILESHYKEMMDIEFTVQENRLWMLQCRTGKRTGKGAVKIAVDMVNEGLIDRRSAIKMVEPRHLDQLLHPQFESPSSYGDKVIATGLPASPGAAVGQIVFTADDAEAWHAQGKSVILVRTETSPEDVGGMNAAAGILTARGGMTSHAAVVARGWGKCCVAGCSGIRVNDAEKVVLVADKVLCEGEWLSLNGSTGEVILGKLPLSPPALSGDLGEFMSWVDEVKKLKVKANADTPADALTARNNGAEGIGLCRTEHMFFSSDERIKAMRQMIMAETIEHRQIALDRLLPYQRLDFEGIFRAMDGLPVTIRLLDPPLHEFLPEGNVEDMVRLLSSGNVYTQEEILTRIEKLSEVNPMLGFRGCRLGISYPELTAMQARAIFEAAISMTEQGVKVFPEIMVPLIGTPQELAQQVDVIREVAEKVFANAETTISYKIGSMIEVPRAALIADEIAALAEFFSFGTNDLTQMTFGYSRDDVGKFLPTYLSKGILQNDPFEVFDQKGVGELVKVAVERGRKARPDLEVGICGEHGGEPSSVAFFAKVGLNYVSCSPFRVPIARLAAAQVML
… et on voudrait connaître sa structure 3D.
Méthodologies de référence (expérimentales) : la caractérisation expérimentale de la structure des protéines est réalisée principalement par cristallographie par rayons X ou par résonnance magnétique nucléaire.
Méthodologies alternatives (prédictives) : on peut obtenir un modèle théorique grâce à des méthodes bioinformatiques. Celle qui donne les meilleurs résultats à l’heure actuelle est la modélisation par homologie. Dans cette méthode, on cherche une protéine homologue (ancêtre commun => probabilité que la structure aura été conservée) à notre protéine d’intérêt, et qui va nous servir de support tridimensionnel pour modéliser la protéine que nous souhaitons étudier. 
Recherche de données structurales
Nous allons rechercher les annotations structurales qui ont été faites dans les bases de données Pfam et UniProt sur notre protéine d’intérêt, et vérifier que la structure n’a pas déjà été déterminée expérimentalement.

UniProt : Base de données de séquences protéiques annotées.

En faisant un Blast de la séquence de la protéine, UniProt retourne un très bon hit nommé PPDK2_ORYSJ. En consultant les informations sur cette séquence dans la base de données UniProt, on apprend notamment que l’existence de la protéine est inférée de l’homologie, on ne peut donc pas affirmer que celle-ci est réellement produite dans la cellule. Elle n’a jamais été purifiée, sa structure n’a donc pas pu non plus être déterminée expérimentalement. 
Pfam : Protein families – répertorie les domaines connus dans les protéines et familles protéiques.

Notre protéine est référencée dans 3 familles de domaines Pfam :  
PF00391
PEP-utilizers.

PF02896
PEP-utilizers_C.
 
PF01326
PPDK_N. 

 
En cliquant sur ces familles Pfam, nous partons à la recherche des autres protéines qui possèdent ces 3 domaines, et dont la structure est cette fois connue. Nous trouvons 7 structures, correspondant à 3 protéines distinctes : 

	Protein name (UniProt)
	Structure code (PDB)

	PPDK1_MAIZE
	1VBG

1VBH

	PPDK_CLOSY
	1JDE

1KBL

1KC7

2R82

	PPSA_NEIMB
	2OLS


CATH et SCOP : bases de données proposant des classifications des structures en fonction des domaines structuraux (CATH : Class/Architecture/Topology/Homology) ou fonctionnels (SCOP : Fold/Superfamily/Family/Domain/Species). En consultant ces bases de données, nous pouvons savoir si toutes ces structures possèdent le même fold général.

Recherche de similarité de séquences avec Blast
Blast : Basic Local Alignment Search Tool – outil d’alignement et de recherche d’homologie (Blastp : protéines).
PDB : Protein DataBank, base de données de structures protéiques.

A partir de la séquence de la protéine d’intérêt, nous recherchons des protéines homologues dont la structure 3D est connue. Pour ce faire, nous lançons l’outil Blastp contre la PDB. Ci-dessous le résultat :
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	1VBG_A
	Chain A, Pyruvate Phosphate Dikinase From Maize >pdb|1VBH|A Chain A, Pyruvate Phosphate Dikinase With Bound Mg-Pep From Maize
	1518
	1518
	98%
	0.0
	83%


Le meilleur hit est celui qui a la plus grande identité de séquence avec la séquence query et la plus grande couverture d’alignement, ici 1VBG (code PDB).

En accédant aux données de la PDB sur cette entrée, on obtient des renseignements sur la méthode expérimentale utilisée, la qualité de la structure, les conditions expérimentales, les auteurs, la publication correspondante, etc. On vérifie que la structure est complète (coordonnées de tous les atomes de la molécule), qu’elle est de bonne qualité (résolution si c’est de la cristallographie), etc. (voir protocole). 

Sélection du/des template(s)
Nos précédentes recherches de protéines support (templates) candidates ont convergé vers la structure 1VBG. Cette protéine présente une forte similarité de séquence (plus de 80% d’identité) avec notre protéine d’intérêt, de plus sa structure a été déterminée de façon quasi complète (excepté les 2 premiers résidus de sa séquence) par cristallographie aux rayons X avec une bonne résolution (2.30Å). Nous allons donc l’utiliser comme unique template et nous obtiendrons un modèle théorique de très bonne fiabilité.
Préparation des fichiers et modélisation
La première étape est la conversion du format de notre séquence FASTA au format PIR pour Modeller. Pour ce faire, nous utilisons la brique Fasta2Pir dans Galaxy.

Le deuxième étape consiste à  aligner la sequence cible avec la séquence de la protéine template. Cette étape vise à obtenir des équivalences de séquences en terme de position dans l’espace. La brique Salign2dbyModeller va utiliser l’information de structure 3D pour aligner les 2 séquences. 

La dernière étape est celle de la modélisation à proprement parler. A l’aide de la brique 3DmodelbyModeller, le programme Modeller va projeter notre séquence dans les coordonnées 3D de la structure template puis  programme va faire tourner un ensemble d’équation et permettre à la protéine de s’accomoder dans une conformation de plus basse énergie. On va obtenir une structure légèrement différente de la protéine de base (quelques acides-aminés). 

Validation

Les outils Verify3D, ProSA-web, Whatif et Qmean, selon leurs propres critères, attribuent tous au modèle une très bonne note attestant de la très bonne qualité du modèle.

Visualisation
PyMOL : outil de visualisation et manipulation de molécules en 3D. Prend en entrée un ou plusieurs fichier(s) au format PDB. 

On charge dans PyMOL le modèle obtenu pour notre protéine. On peut mettre en évidence différents aspects de la structures ; les chaînes latérales, les structures secondaires, l’ordre séquentiel des résidus d’acides aminés… (figures). On peut aussi faire apparaître certains résidus spécifiques (les aromatiques, les chargés, etc.) selon ce que l’on souhaite étudier. On peut voir si le ligand (PEP) présent dans la structure 1VBH s’accomoderait dans notre protéine.
Conclusion
Nous avons obtenu un modèle théorique pour la protéine d’intérêt. Ce modèle a été construit par modélisation par homologie, méthodologie prédictive qui a largement fait ses preuves ces 20 dernières années. Nous avons eu recours à la structure d’une protéine homologue proche (puisque très peu divergente en terme de séquence), annotée comme ayant la même fonction que la protéine d’intérêt (PPDK) dans une autre espèce. La structure expérimentale est de bonne qualité. Pour toutes ces raisons, le modèle obtenu est également de bonne qualité, et il pourra être utilisé à des fins variées (voir cours). Sa précision autorise de l’exploiter pour des analyses aussi fines que le docking ou le design de ligands.

Cours 9 : Annotation de séquences génomiques : gènes

Comment sont distribués les gènes le long d’une séquence ? L’annotation structurale permet de determiner quelle est leur structure (introns-exons, site d’épissages, UTRs ect) , et l’annotation fonctionnelle permet d’attribuer une fonction putative.
Les logiciels de prédiction sont basés sur la structure des gènes. Les gènes sont bordés par des UTR, 1er exon commence par une méthionine et se termine par un codon stop. La plupart des introns commencent par GT et se terminent par AG. La présence de structure incomplète n’est pas toujours attribuable à un pseudo-gène.
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Méthodes intrinsèques (ab-initio) d’annotation automatique
Ces méthodes sont uniquement basées sur des modèle probabilistes (ex : HMM = Hidden Markoff Model) et permettent notamment de distinguer les régions codantes des régions non codantes. Pour permettre une annotation automatique pertinante, ces logiciels ont besoin d’un set de séquences d’entrainement (training set). Il est réalisé en alignant des des cDNA pleine longueur sur l’ADN génomique, et la structure des gènes en est déduite.

Méthodes extrinsèques

Alignements : Les méthodes intrinsèques ne suffisent pas, pour les compléter les méthodes extrinsèques consistent à comparer la séquence à annoter avec des bases de données (alignements ADNg – Protéine ; ADNg – ADNc ; ADNg – ADNc) = BLAST).
Recherche de signature : (ex : interproscan) Ces outils vont scanner la séquence et rechercher des signatures de domaines protéiques conservés.
On peut filtrer les éléments répétés avant l'annotation des gènes car ils peuvent être confondus avec des gènes et perturbent les prédictions de structure des gènes (souvent à cause de leur taille).

L’annotation automatique est un équilibre entre vrais et faux positifs. Le calcul de la sensibilité et de la spécificité de l’annotation permet d’en estimer sa pertinence (voir support de cours).

Les méthodes intégratives (outils = combiner) associent les méthodes intrinsèques et extrinsèques et couplent les capacités. Ex : EuGène (utilisé lors du TD) .
EuGène utilisé pour différents génomes (TD)
Le but du TD est d’utiliser un « pipeline » ou « workflow » (implémenté dans galaxy) combinant des approches intrinsèques et extrinsèques pour annoter une séquence génomique, puis de réaliser l’annotation manuelle (expertise) à l’aide de l’outil « artemis » 

On lance le Workflow « EuGène » avec les deux fichiers d’entrée suivants : 

· - 1: Os01_36429_36558.fna (Step 1: GNPAnnot format sequence: Fasta) = sequence génomique à annoter
· - 2: Os01_36429_36558.fna.raw.fg (Step 2: GNPAnnot Converters : FGenesH) = prediction automatique réalisée avec FgenesH (préalablement réalisée) 
Détail du Workflow

Fichier FGeneH : on y trouve le détail de la structure de tous les gènes prédits. Prédictions et séquences protéiques.

1ère partie : Eugene : prédiction structurale, les fichiers Gff3 et embl pourront être utilisés sous Artemis.

Voir support de TP

Visualisation des résultats sur Artemis

Réponses questions du TP

Q1 : Combien de structures codantes sont-elles prédites par Eugène ?

31, les structures (exons) composant un gène sont reliées. Astuce : Avec Shift on peut sélectionner l’ensemble des séquences codantes dans la fenêtre 3. Les éléments sélectionnés sont comptabilisés dans la barre gris clair juste au-dessus de la fenêtre 1.

Q2: Quel est le numéro du gène (identifiant ou locus_tag) ? Sur quel chromosome du Riz se trouve la région étudiée ?

Le locus_tag correspond à l’identifiant du gène. Cet identifiant est unique. Les 2 premier caractères « Os » renseignent sur l’espèce (ici Oriza sativa), les 2 chiffres suivants « 01 » renseignent sur quel chromosome se situe ce gène (chr 1). 

On est sur le chromosome 1 du riz lu grâce au code Os01… (Oryza sativa, chromosome 1)

Q3: Quelles sont les différences de structure entre la prédiction EuGène et celle de Fgenesh ? A quoi cela peut-il être dû ?
Le début d’un gène est la partie la plus variable et donc la plus difficile à prédire. EuGène et Fgenesh (ab initio) n’utilisent pas le même jeu d’entrainement, ce qui explique la petite différence entre la prédiction du premier site accepteur. Fgenesh a analysé la séquence non masquée (éléments répétés non filtrés) et a prédit 2 structures distinctes, alors que EuGène a prédit une seule structure. En affichant dans artemis le fichier « repeatmasker » ont peut voir qu’il y a des séquences répétés dans un intron du gène ce qui explique pourquoi FgenesH avait mal prédit le gène (coupé en 2).

Q4: Peut-on émettre l'hypothèse que ce premier gène est exprimé Chez Glaberrima ? Chez le sorgho ?

D’après la comparaison avec Exonerate (ESTs Riz Glaberrima)  on peut dire effectivement que ce gène est potentiellement exprimé chez Glaberrima. Il existe bien un cDNA Glaberrima qui correspond à ce gène.

Le sorgho en revanche n’est pas très bien annoté donc il est difficile de tirer des conclusions. Il faudrait corriger manuellement l’annotation du gène sorgho et relancer les comparaison avec les bases de données pour conclure.
Q5: Quelles sont les différences de structure entre la prédiction EuGène et celles d’Exonerate ?

Exonerate permet d’aligner un cDNA sur de l’ADN génomique. Il force le cDNA à se mettre en un seul morceau sans codon stop. S’il y a une zone de similarité elle doit être totale. Il y a de fortes chances pour que le 4ème exon soit effectivement présent (voir Exonerate).

[image: image26.png]=181]

File Entries Select Viey Goto Edit Create Run Graph Display

Eubene. eubl

Encry: Exonerate_06_ngs. enbl. [7)Exonerate_08_nrnas.eabl []Exonerate Rice.enbl 0s01_s622

7 selected bases on reverse strand: 121282..121288 = complement (7713..7719)

ey ey e et 0y s )
a0 T O CObDQgo0Dg =9 | OO o D

B OO0 =9 O /D

12
Tooso Tesso Tosoo Teoso rzso rsso reso oo oaso o0 Tooso oaso Tosoo ssso i
| P e

Il | T

P ow L0S TN VIS TTINHES FEGEVTHEGLV L+

0 T R E D EY YN QS M T§ VL QS TIASCDLEPNEKDLEFCRLLETLFLREHTIABRGUYFS#L T LSV LAEUTRSND
S K B D v 15 TTIWQco EYYN QS+ 1BV ICNQrRTCFYVOC RS CEYENILYIcCS P NYFTYrs Lo To KM
CAAACACEA T TG TAAGTAC T CARTCAATCAR TG TAAGTACTAC AN TEART AT AT AT TEA T TR AR GAAGEACT T TG TA GG TG TARAGAT TG T T SACABACATHTTCCCE AT GG TOT T TC AR AT TTTCAGTECCOT CCTOATGCCT TG TREAGGTAMRATGAT,
saso0 Josso Jeozo Jssao Josso Josso Jroso Jrozo Jroa0 Jroso Jro
T TTOToCTACACTAT Ao AT TTA TTAC TTACAC T CATO AT TTAG TTACTATCCAAGTACACTAAA A TG A IO TEAACAAACATECAA AT T A AACAAAACTC T T TATAAC GG TAACCCACAACAGSATTAKTAARAACTCAS GCAG ACTACCCAACCATETECATTTTACTAL
L C S T I LYV ILTHSILY+LtDYS*TIOLUBKLOYOKTD?Q+ LD 0K S FHN G HPHESLSKQTGDOQRRDYPLII
6 ¥ v T H Y TS cD TLTILYVYIL L KNENTOYLSESTEYTALSRTESFVYQOoNPTRRIIKSDRGSAKTCTEHY
PR NS LY Lt IN TS D IKAERSKYOITSKEGLNSTIRNEITCIADOTNIsNNELCTRIGOTLITIS
< I

qene w5 o7
0 oos 1124 9383 0301b36429636556_p0010- amine acid kinases2C puratives2C expressed- PSCS- complete
gene sa00 13079 ¢
0 oos 10796 12776 ¢ 0s0b36429e36558_p0020 CRRZAZC putarives2C expressede CRRZ~ complete
gene 15255 1376
s Virs 1o7is
gene Laan 20156
0 oos 15567 13459 ¢ 0s0b36429e36556_p0040- homeodonsin proteint2s putarives2 expressede BLES~ complete
gene Zoast 220
s Sioes st
gene Sasea 25208
it D

Eu

Hvémane| | @ & 7 &

| 15 Ziose optionnet3 3o...| (1] Notes formation bionfor... | (W] annotaton_genes.doc ... | (@) Formation (0#-09j02(20... | § artemisRelease 13.2.0 ||} Artemis Entry Edit:

DO @ 145





[image: image27.png]i Artemis Entry Edit: EuGene.embl

File Entries Select View Goto Edit [reate Run Graph Display

Entry:

One selected base on reverse strand: 122556

Exonerate_05_urnas. eubl

omplenent (6445)

Exonerate_SB_urnas. eubl

=181]

onerate_SmissProt. eubl (] Foenest. cubl [v] 0s01_3642

Ju1200

Jn2000

gooE e O OobogoE0 o ©OOpo oD
W e
[bs01n36425e36558 o010 12
Jooo lisso0 0 ozso Taoso Tasso Tosso 223 rzso Tooso Tosoo Tosso J10a0o
(05011364292 36558 q0020
B lreos] a

1 |

e T T

oo

rsso reso

raos

rov

oo

roso Tooso oo

1 Ll

|
Ll

BLASTCDS 1193 9679
| BLASTCDS 10799 11944
LASTCDS 10799 11944
LASTCDS 10799 11944
LASTCDS 10799 11944
LASTCDS 10799 11944
LASTCDS 10799 11944
LASTCDS 11573 11929
LASTCDS 11573 11929
LASTCDS 11573 11929
| BLASTCDS 11573 11929

Psasss
vzl
vzl
vzl
vzl
vzl
vzl
vzl
vzl
vzl
vzl

Delta-l-pyrroline-S-carboxylate synthase B 03%3DArabidopsis thaliana GNY3DPSCHB PEY3DZ §V43DL

Pentatricopeptide
Pentatricopeptide
Pentatricopeptide
Pentatricopeptide
Pentatricopeptide
Pentatricopeptide
Pentatricopeptide
Pentatricopeptide
Pentatricopeptide
Pentatricopeptide

repeat-containing protein At3gs7430:2C
repeat-containing protein At3gs7430:2C
repeat-containing protein At3gs7430:2C
repeat-containing protein At3gs7430:2C
repeat-containing protein At3gs7430:2C
repeat-containing protein At3gs7430:2C
repeat-containing protein At3gs7430:2C
repeat-containing protein At3gs7430:2C
repeat-containing protein At3gs7430:2C
repeat-containing protein At3gs7430:2C

chloroplastic
chloroplastic
chloroplastic
chloroplastic
chloroplastic
chloroplastic
chloroplastic
chloroplastic
chloroplastic
chloroplastic

05%3DArabidopsis
05%3DArabidopsis
05%3DArabidopsis
05%3DArabidopsis
05%3DArabidopsis
05%3DArabidopsis
05%3DArabidopsis
05%3DArabidopsis
05%3DArabidopsis
05%3DArabidopsis

thaliana
thaliana
thaliana
thaliana
thaliana
thaliana
thaliana
thaliana
thaliana
thaliana

GH3DPCHP-HBL
G3DPCHP-H8L
G3DPCHP-H8L
G3DPCHP-H8L
G3DPCHP-H8L
G3DPCHP-H8L
G3DPCHP-H8L
G3DPCHP-H8L
G3DPCHP-H8L
G3DPCHP-H8L

PES3DZ
PEX3DZ
PEX3DZ
PEX3DZ
PEX3DZ
PEX3DZ
PEX3DZ
PEX3DZ
PEX3DZ
PEX3DZ

sva02
sv:302
sv:302
sv:302
sv:302
sv:302
sv:302
sv:302
sv:302
sv:302

i

D

Hvémare| | @ & 7 &

| @ | 3 2:odule optionneli 3o.. | (W] oes formation bionfor.. | (W] snnotation_ genes.doc .. | @) Formaton (04-09/02/20... | § artems Release 13.2.0

(% artemis entry Edit: Eu...

[@0° @ =12




Sur la terminaison, les deux prédicteurs ne sont pas en accord entre eux, ni avec les Exonerate. Difficulté de la prise de décision…

Q6: Comment exploiter ce résultat pour rechercher de la microsynténie entre cette région du riz et les chromosomes du Sorgho ?
Q7: Sur quel(s) chromosome(s) du sorgho se trouvent des régions synténiques potentielles ?

Pour verifier si il existe une région orthologue chez le sorgho, il faut vérifier si on retrouve chez le sorgho les gènes prédit sur le riz (ici chr1) . Le fichier de comparaison avec le génome du sorgho nous permet de voir clairement que les gènes prédit sur notre séquence sont retrouvés également sur le chromosome 9 du sorgho. Il y a donc de la micro-syntenie entre ces 2 régions chromosomiques : Os01 – Sb09
Q8: Quelles sont les différences de structure entre le premier gène prédit par EuGène et celle d’Exonerate ?

Q9: Est-ce que les résultats attendus correspondent aux résultats observés ?

SwissProt est une base de données protéique fiable (les séquences déposés sont vérifiées systématiquement par des annotateurs = bio-curateurs). La protéine a l’air extrêmement conservée entre le riz, le sorgho et A. thaliana.
Dans un pipeline d’annotation automatique, Il existe des règles de poids d’information en fonction de l’origine des données et de leur fiabilité. Par exemple, si on a un alignement avec un cDNA de la même espèce, le poids sur la prédiction sera important.
Q10: Quelles sont les différences de structure entre la prédiction EuGène et celle d’Exonerate ?

Annotation structurale dans Artemis

Pour vérifier et corriger manuellement l’annotation, nous utilisons l’outils « Artemis ».

1- on créait une entrée (new-entry) que l’on passe en entrée par défaut. Entries => Set Default Entry.

2- On copie le gène prédit automatiquement par Eugène dans cette nouvelle entrée. 
Transfère d’annotation (sur base de similarité de séquence) :
Ajout de l’exon manquant (exon 4), on repère les coordonnées de l’exon manquant dans la piste « exonerate », puis on édite le gène à corriger grace à la fenêtre d’édition (clic sur le gène pour le selectionner, et Ctrl+E). On transfère les coordonnées de l’exon manquant puis on valide (OK) . On vérifie ensuite que l’ajout de cet intron ne perturbe pas la structure initiale (vérification des sites d’epissage et de la phase des exons) . les introns sont bien délimités par GT et AG.
Attention, en présence d’hétérologues (exemple riz et sorgho), les UTR sont souvent mal prédites et mal conservées.

Les UTR ne sont pas des CDS (séquences codantes), elles ne se placent donc pas sur les séquences d’ARNt. Pour les créer : Create => New feature et insertion des coordonnées dans la fenêtre d’édition.

[image: image28.png]O OO ooog o Doob

BO00 O OD
O Ooooooo o oooo o

5
3
w00 Teaso rzso Tooso Tosoo 1

Mo ibaFas0e





Pour soumettre cette annotation à GeneBank, il faudra renseigner obligatoirement certain « qualifiers », par exemple les qualifier « locus_tag », « product » . Pour renseigner les « qualifiers » ( Ctrl+E sur le gène.

Finalement, on enregistre la nouvelle entrée que nous avions créé au format « EMBL ».

File => Save an Entry as => EMBL Format => Mon entrée

En bref

Familiarisation avec Artemis. 
Attention à la confiance que l’on accorde aux bases de données.

Implication des séquences répétées dans la détection de gènes.
L’annotation manuelle est un travail minutieux et couteux en temps. On réalisera l’annotation manuelle sur des régions ou l’on recherche par exemple un gène d’intêret.

Ne pas cocher





Endroit de Match (donc ici en position reverse





Nom de la séquence





Match à partir de …. jusqu’a





Miss match





Miss match





% d’identité





Nombre de nucléotides qui « match»





Arc-en-ciel de couleur de l’extrémité N terminale à l’extrémité C-terminale, molécule format « ribbon ». 





Arc-en-ciel de couleur de l’extrémité N terminale à l’extrémité C-terminale, molécule format « stick » : on voit toutes les chaînes latérales des acides aminés.





Hélice Alpha (rouge), Feuillet Beta (jaune) et boucles de connexion (vert) 











�Attention la dénomination des reads a évolué. Dans les nouveaux fichiers, il n'y a plus de /1 /2. Maintenant, le sens est indiqué, avec d'autres informations, après un espace dans le nom du read.


�Je comprend pas ce que vous voulez dire. Le TAG est effectivement une petite séquence ajouté à l'extrémité de la séquence à séquencé (mais qui elle même n'est pas séquencée). Elle permet de différencier dans un même run les séquences ayant des origines différentes. Par exemple dans notre cas, elles permettent de savoir à quel individu appartient une séquence.


�A 75 quoi ? Si c'est 75 bp, on ne coupe pas toutes les séquences à 75bp. Seulement celles de mauvaise qualité.


�Ne pas confondre overrepresented sequences et Sequence duplication levels. La première montre effectivement une séquence surreprésenté, par exemple un ARN ribosomique ou Rubisco. La deuxième montre un read qui a séquencé plusieurs fois. C'est ce qu'on appelle un dupliquat optique.


�Pas tout à fait...


�?


�Pas par défaut. C'est l'objectif du tri.


�M signifie match OU mismatch


�Quel champ? Si c'est le NM alors ce n'est pas que les mismatch, les indel sont aussi pris en compte





